Table of Contents

Chapter 1  Getting Started ................................................................. 3
   1.1 Accessing the WCMS .............................................................. 3
   1.2 NUIT Web Guidelines ............................................................. 3
   1.3 Logging in to the Web Content Management System .............. 3
   1.4 The Dashboard ........................................................................ 4
   1.5 Navigating the Web Content Management System (WCMS) ... 4
      1.5.1 Navigation Tab Definitions .............................................. 4
      1.5.2 Navigating Files and Folders ........................................... 5

Chapter 2  Understanding Workflow .................................................. 6

Chapter 3  Create Pages from Basic Page Asset Factory ..................... 7
   3.1 Understanding Basic Page Architecture .................................. 7
   3.2 Creating a Basic Page ............................................................. 7

Chapter 4  Asset Management .......................................................... 11
   4.1 Uploading a File ..................................................................... 11
   4.2 Uploading an Image .............................................................. 12
   4.3 Editing an Uploaded Asset .................................................... 13
   4.4 Locking an Asset .................................................................. 13
   4.5 Deleting an Asset .................................................................. 13
   4.6 Moving or Renaming an Asset ............................................... 14
   4.7 Viewing History ..................................................................... 14
   4.8 Managing Versions ............................................................... 14

Chapter 5  Editing Pages ................................................................. 15
   5.1 Previewing a Page ................................................................. 15
   5.2 Editing a Page ....................................................................... 15
   5.3 Using the WYSIWYG Editor ................................................... 15
      5.3.1 Inserting an Image .......................................................... 16
      5.3.2 Inserting a Hyperlink ...................................................... 17
      5.3.3 Using HTML Toggle ....................................................... 17
      5.3.4 Inserting a NUIT Formatted Table ................................. 17
      5.3.5 Using Styles ................................................................. 18
   5.4 Saving and Publishing Pages ................................................ 18
   5.5 Deleting Pages ....................................................................... 19

Appendix
   6.1 Glossary ............................................................................... 20
   6.2 Northwestern University Information Technology (NUIT) Web Business Processes for Using the NUIT WCMS ................. 25
Welcome to the NUIT Web Content Management System (WCMS). The WCMS is a resource for NUIT Web Contributors that allows them to quickly and easily add, edit, and remove content, ensuring that the NUIT Web site maintains current information. The WCMS uses templates to automate updates and utilizes task management and workflow to streamline the content updating process. Because of the secure nature of the system, all users must be granted access to resources in the WCMS in order to log in and manipulate content.

1.1 Accessing the WCMS
You will be accessing the WCMS as a Contributor. A Contributor is defined as a user who has permission to make updates to a defined page or pages within the WCMS. You are considered the content expert for your assigned page(s), and when pages are sent to IT Communications for deployment, it will be assumed that all content is accurate and ready to be viewed on the Web.

Contact IT Communications to gain access to the WCMS:
it-communications@northwestern.edu

1.2 NUIT Web Guidelines
Please read the Northwestern University Information Technology (NUIT) Web Guidelines document, located in Appendix of this manual. This guide has been created in support of University guidelines supporting the University and NUIT brands and it will be adhered to by all of NUIT. The NUIT Web Guidelines can also be found online at http://www.it.northwestern.edu/bin/docs/NUIT_Web_Processes.pdf.

1.3 Logging in to the Web Content Management System
To log into the NUIT-MAIN WCMS, perform the following steps:

   a. NU Online Passport displays

   Need Help?
   Contact the NUIT Support Center
   (847) 491-HELP (4357)
   consult@northwestern.edu

   What is NU Online Passport?
   Trouble Logging In?
   Quick Reference
   http

   Please note:
   • To use Online Passport, your browser must be set to accept cookies.
   • When you finish your session, close your browser to log out.

2. Enter your NetID and NetID Password.
3. Click Log In button.
4. Select the NUIT-MAIN site in the upper left corner.

1.4 The Dashboard

After logging into the NUIT-MAIN site, the default content area will display your personal dashboard. You can get back here at any time simply by clicking Home in the upper left corner of the top navigation menu.

The Dashboard enables easy visual recognition of active workflows, waiting messages, locked assets and a list of recently visited items. Workflows, messages and locks are also available as tabs. Tabs offer a more comprehensive listing of each category.

1.5 Navigating the Web Content Management System (WCMS)

Once you have logged in to the WCMS, you will see tabs that allow you to perform functions in the system. You will be able to create tasks initiating a workflow, complete assignments that have been assigned to you, upload images, add pages, and edit content. You will only be able to see resources that you can change.

1.5.1 Navigation Tab Definitions

- **Home**: The Home tab provides access to the Inbox, which displays Current Tasks and Notifications.
- **New**: The New tab allows you to create new assets.
- **History**: Displays a history of recent assets accessed during your current session.
1.5.2 Navigating Files and Folders:
Using the base folder asset tree found in the left side of the screen, click the Collapse All (-) and Expand All (+) icons to reveal folder structure.

Note:
- The System Name corresponds to the URL on the NUI T site. System Names may not have spaces or special characters. Use hyphens (-) instead of underscores (_) when creating System Names.
- The System Name will appear as an html document extension on the live page.

For example, notice the index page is within the training folder.
The URL of the about index page reads as:
http://www.it.northwestern.edu/hardware/index.html

<table>
<thead>
<tr>
<th>it.northwestern.edu/</th>
<th>training/</th>
<th>index.html</th>
</tr>
</thead>
<tbody>
<tr>
<td>This is the main server hosting your site</td>
<td>This is a sub-folder within the it.northwestern.edu directory.</td>
<td>This is the name of the Web page, “index”. The asset type is indicated by the suffix, or file extension that follows the period: html = Web page pdf = PDF gif = image jpg = image zip = ZIP, or compressed archive file</td>
</tr>
</tbody>
</table>
Understanding Workflow

When creating Web content (assets: a basic page, document, image, etc.), workflow is employed through a series of ordered steps that content must go through to be quality-checked, and either approved, modified, or disapproved by the appropriate user before being publish-ready.

Workflows provide NUIT WCMS users with a customizable, assignable method of assuring that content (any asset) is checked multiple times by multiple users before being published. The resulting diversity of input ensures that content is accurate and presented in a professional manner.

All Contributors will initiate a workflow when creating, editing, or deleting assets. Higher-level users, such as the WCMS Manager role, review assets, and either approve assets to be sent to the next step in workflow, or return assets to the associated contributor for changes. After the content has been approved, it then may be published to the live site. The WCMS Manager role has the capability to bypass any of these steps anywhere in the workflow process.

The IT Communications team is the Business Owner of the NUIT Web site and holds the WCMS Manager role within Cascade. IT Communications will deploy all assets, thus closing out all workflow tasks.

NUIT Web Site Content Update Workflow
Create Pages from Basic Page Asset Factory

3.1 Understanding Basic Page Architecture
The WCMS utilizes a Basic Page Asset Factory to ensure consistency of the look and feel for the NUIT Web site, as well as user friendliness of the system. Once the Basic Page template is selected, the user populates various fields to design the page.

A Basic Page template consists of the following field regions:

3.2 Create a Basic Page
Use the following steps to begin to create a Basic Page.
1. Use the left sidebar to navigate and select the folder where the new Basic Page will reside.
2. Select the New tab on the top menu bar and navigate to Pages > Basic Page.
3. Your main screen should now display the Create New Page menu.
4. Under the Content tab in the Inline Metadata section, complete all required fields.
   You will see the following fields and options:
   - **Display Name:** This is a required field. Populate this field with a short name of the page. This field will populate the additionalInfoNav header located in the Navigation Menu. **Note:** The value populated in Display Name field when creating a new page will also be the page’s default System Name. Spaces will automatically be converted into hyphens for the System Name.
   - **Title:** This is a required field. Populate this field with a long name of the page. This field will populate the Title region.
   - **Keywords:** Populate this field with keywords that relate to the content of this page. Use commas (,) to separate multiple keywords.
   - **Description:** Populate this field with a description of the page.
   - **Left Sidebar Style:** This option will stylize the navigation menu. By default Navigation Menu will be chosen.
   - **Block searching of this page:** This option will prohibit the page from being searchable by any search engine.

5. Scroll down and fill in Body Contents using the WYSIWYG editor. This section can be edited just as you would using a standard word processor. **Note:** Please refer to section 5.3 for more information on WYSIWYG features.

6. Scroll down and populate the additionalInfo and additionalInfoNav boxes.
   - The additionalInfo section appears at the bottom of a basic page, under the Additional Information header. This is a good place to link to downloadable documents such as PDFs of meeting notes, instructions, or presentations. Any relevant internal or external links referenced in the page can also be replicated here.
• The **additionalInfoNav** section appears at the top left of a basic page. This is a good place to put relevant internal links, such as to a Quick Reference page. Avoid putting external links or links to downloadable documents in the additionalInfoNav section.

• Use the **“Show below info on the page”** radio buttons found above each box to control visibility of these regions on the published page.

7. Scroll down and populate the **Notice Box Contents** section, if necessary. The Notice Box, if enabled, displays a yellow highlighted box at the top of the page. The Notice Box is to be used for important announcements, such as outage notifications and upcoming upgrades. Select the **Yes** radio button next to **Show notice box?** to enable the Notice Box.

8. Scroll to the bottom of the page and click **Submit**.

9. A **Start Workflow** screen will appear. Click **Submit** again.

10. Your screen will refresh and a green context bar will appear informing you that the page has been created. You will now select one of two options:

    • If you wish to submit the page for publishing click **“Submit for publishing”**.

    • If you wish to save your page for further editing or to see a preview of the page click **“Continue editing”**.
11. Enter any relevant notes into the comment box. Anything entered here will be sent to the WCMS Managers. It is recommended that you briefly describe your changes made to the page, but comments are optional. Click Submit.

If “Continue editing” was selected, your screen will display your Page in edit mode. You will then be able to preview your page and make further revisions. If “Submit for publishing” was selected the workflow detail page will display. IT Communications will review your submission. If approved, the page will be deployed to the NUIT Web Site and notification will be sent confirming completion of the workflow.
4.1 Uploading a File
Upload downloadable files such as PDFs to Base Folder/bin/docs. If you are uploading a large number of files for a specific project or department, you can request that a new folder be made in Base Folder/bin/docs to house them. Contact it-communications@northwestern.edu to request a folder.

When linking to a downloadable file, indicate the file type. If the file is unusually large, also indicate the file size. Small graphics to indicate PDF, DOC, XLS, and PPT are available in Base Folder/images/glyph. If using these images, place them after the text link.

To upload a File to the WCMS, perform the following steps:
1. Select the New tab located on the top navigation bar and navigate to Files > File – PDF, Doc, XLS.
2. Your screen will now display the Create File menu.
3. Under the Create > Content tabs, click the Browse button next to the File Upload field.
4. A browser window will appear. Navigate to and select the file you wish to upload.
5. Once the File Upload field is populated with the file location, click at the bottom of the screen.
6. Your screen will refresh and the Start Workflow screen will appear. Click Submit.
7. Your file will be uploaded to the /bin folder under NUIT-MAIN Base Folder. If you wish to submit the file for publishing click “Submit for publishing”. If you wish not to publish your file click “Continue editing”.

![Cascade Server](image)
4.2 Uploading an Image

Upload images to **Base Folder/images**. If you are uploading a large number of images for a specific project or department, you can request that a new folder be made in **Base Folder/images** to house them. Contact **it-communications@northwestern.edu** to request a folder.

To upload an image to the WCMS, perform the following steps:

1. Select the New tab located on the top navigation bar and navigate to **Files > Images – GIF, JPG, PNG**.
2. Your screen will now display the Create Image menu.
3. Under the **Create > Content** tabs, click the **Browse** button next to the **File Upload** field.
4. A new browsing window will appear. Navigate to and select the image you wish to upload.
5. Once the **File Upload** field is populated with the image location, click **Submit** at the bottom of the screen.
6. The Start Workflow screen will appear. Click **Submit**.
7. Your image has been uploaded to the **/images** folder in NUIT-MAIN Base Folder. If you wish to submit the image for publishing click **Submit for publishing**. If you wish not to publish your image click **Continue editing**.

8. You will then be prompted to enter notes into a comment box; this is optional. Click **Submit**.
9. If “**Continue editing**” was chosen, your screen will display the image’s edit page. If “**Submit for publishing**” was chosen, the image’s workflow detail page will display.

**Note**: Images that require uploading to the WCMS should not exceed 50K. Please format your image to an acceptable size and resolution before uploading.
4.3 Editing an Uploaded Asset
If you wish to replace an uploaded document or image with an updated version, you may edit the asset instead of creating a new one. This will automatically update all links to that asset from other pages.

1. Navigate to the asset to be updated.
2. Click the Edit tab.
3. Click the Browse button next to the File Upload field.
4. A new browsing window will appear. Navigate to and select the image you wish to upload.
5. Once the File Upload field is populated with the image location, click Submit at the bottom of the screen.
6. The Start Workflow screen will appear. Click .

4.4 Locking an Asset
There may be times when you will need to edit an asset, while preventing other users from making changes to the same asset, for an extended period of time. In such cases, you may manually lock the asset. Unlike the automatic locks that are created during editing, the manual locks do not automatically expire. The asset must be unlocked by the same user or by an administrator. Perform the following steps to lock assets:

1. Start by locating and selecting a page in the asset tree that you want to lock. In this case, we are locking the training /index page.
2. Under the View tab, select the Lock pane.
3. Click Check out this asset.

Perform the following steps to unlock assets:

1. Start by locating and selecting a page in the asset tree that you want to unlock.
2. Under the View tab, select the Lock pane.
3. Click either the Break lock disregard change or Commit changes.

4.5 Deleting an Asset
To delete an asset, perform the following steps:

1. Start by locating the asset you wish to be deleted in the file tree and click the asset.
2. Once the page has loaded, click on the More tab located above the page.
3. Select Delete from the More tab menu.
4. Click Submit.
5. The Start Workflow screen will appear. Input comments regarding reasons for asset deletion and click Submit again.
6. The workflow detail page will display. IT Communications will review your submission. Notification will be sent confirming completion of the workflow. Note: You are able to access deleted pages in the Recycle Bin, located in the Home Dashboard, for up to 15 days post-deletion.

4.6 Moving or Renaming an Asset
To move or rename an existing asset, contact IT Communications at it-communications@northwestern.edu.
4.7 Viewing History
Viewing History allows you to see a list of your most recently viewed assets, and it provides for easy navigation. **Note: The history is cleared each time you log out of the system, so you’ll only see assets that you’ve viewed during the current session.**

1. To view history, you can click on the History tab, located in the top navigation menu. It can also be accessed from the Dashboard under My Recent History.

2. You will be forwarded to the History screen where you will see a list of your most recently viewed assets.

3. Click on any item name and it will take you the relevant page regarding that item. You can also use the Back button on your browser any time you want to go back to a previous screen.

4.8 Managing Versions
The WCMS automatically saves a version of an asset every time changes are submitted. These versions can be viewed or activated as needed. To view a version of an asset do the following:

1. Select the desired asset and click on the More tab.

2. Select Versions from the drop-down menu.

3. You will see a list of versions showing for each version:

- **Path:** The name and path for the current asset (this will be the same for each version, unless the asset has been moved or renamed at some point).
- **Last Modified On:** The date that this asset was last modified.
- **Last Modified By:** The System user who last edited the asset.
- **Comments:** Any comments relevant to a particular version.

4. Click on the version you want to view, and it will open in the main view. You will see an added “viewing” bar, allowing you to select the following actions:

- **More Recent:** Scroll through to a later version.
- **Less Recent:** Scroll through to an earlier version.
- **Original:** Reverts back to the active or current version.
- **Activate:** Makes the currently viewed version the active or current version.
- **Delete:** Deletes the currently viewed version from the versions list. **Note: Deleted versions cannot be recovered. NUII recommends against deleting versions.**

5. Click the action you wish enabled.
Editing Pages

5.1 Previewing a Page
Previewing will display how the page will look when published to the NUIT Web Site. To preview a page, perform the following steps:

1. Start by locating the page in the NUIT-MAIN asset tree and click on the page you would like to edit.
2. Once the page has loaded, click on the View tab located above the page.
3. Click the Preview sub-tab.
4. From here you will be able to see preview of what your page will look like when published.

5.2 Editing a Page
To edit a page, perform the following steps:

1. Start by locating the page in the NUIT-MAIN asset tree. Then click on the page you would like to edit. In this case, we are editing the training/index.
2. Once the page has loaded, click on the Edit tab located above the page next to the active View tab.
3. From here you are able to edit all the content of the page. Make the desired changes to the document. While you are editing, the asset is automatically locked to prevent other users from accessing the same asset while it is being edited. When edits have been made and the asset has been submitted, the asset is automatically unlocked so that other users can access it.

5.3 Using the WYSIWYG Editor
The word processor, also called the WYSIWYG (What you see is what you get) editor, that is integrated into the WCMS system has the same functionality and features you are most likely accustomed to using in a standard editor. The button functions are as follows:
Please try out some of the different toolbar buttons in the word processor to become more acquainted with how they work.

5.3.1 Inserting an Image Using WYSIWYG

To insert an image using WYSIWYG, perform the following steps:

1. Place your cursor in the area desired for the image, and then click on the insert image icon on the toolbar.

2. The insert image window will appear.

3. Click on the Internal tab to insert a WCMS managed image. Note: To insert an external image, click on the External tab and type in the full URL for the image to which you wish to insert (i.e. http://www.domain.com/example.jpg).

4. On the Internal tab click the icons to open a new window that will allow you to select an image to insert. Use the icon to deselect an image.

5. Populate the Alternate Text field with the text representation of the image.

6. Click Insert.

Note: To upload a new image in the WCMS, you will need to use a separate process. Please see 4.2 on Uploading an Image for more information.
5.3.2 Inserting a Hyperlink Using WYSIWYG
To insert a hyperlink using WYSIWYG, perform the following steps:
1. Highlight text or an image you wish to turn into a hyperlink in your WYSIWYG box and click the insert web link icon on the toolbar.

2. The insert link window will appear.

3. Click the Internal radio button to link a WCMS managed asset. **Note:** To link to an external resource, click on the External radio button and type in the full URL for the resource to which you wish to link (i.e. http://www.domain.com).

4. Click the icons to open a new window that will allow you to select a page to link to. Use the icon to deselect a linked page.

5. Click Insert.

5.3.3 Using HTML Toggle
Users wishing to edit content in HTML may click on the HTML icon inside the WYSIWYG. To return to the WYSIWYG view without submitting changes, the user may turn off the HTML view by clicking the icon again.

Advanced users who wish to tweak the content of a page via the HTML code may simply click the HTML toggle icon to switch back and forth between views. Content may be submitted via either view.

5.3.4 Inserting a NUIT Formatted Table
Within the WYSIWYG editor, you may easily create, copy, and delete tables. To create a table:
1. Place the cursor in the editor so that it is in the desired location for the table.
2. Click the Insert Table icon.

3. An Insert Table dialog will appear.
4. Click on the General Tab.
5. Populate the number of Rows and Columns for the table. **Note:** Other options include the table’s Alignment, Border thickness, Cell Spacing, Cell Padding, and Column Width.
6. Select “(value)” from the Class drown down.

7. Populate the Class field with “alternate_rows”.
8. Click on the Advanced Tab.
9. Populate the Id field with “anyid”.
10. Click Insert.
11. Right click any cell on the first row of your table.
12. Select Cell > Table cell properties.
13. A Table Cell Properties box will appear.
15. Choose “Update all cells in row” from the dropdown box located above the Update button.
16. Click Update.

5.3.5 Using Styles
The Style dropdown allows users to select specific CSS classes in the WYSIWYG editor. To employ a style, highlight the text you wish to be red in your WYSIWYG box and select the desired style from the -- Styles -- dropdown. Applied styles will have a symbol next to their names.

Available styles include red, blue, and lime green text color, bgyellow highlighted text, and code monospaced text. To remove a style, highlight the styled text and select the applied style again.

5.4 Saving and Publishing Pages
Once all changes to the asset have been applied, scroll to the bottom of the page.
1. Click to make the changes to the asset available to all users or to publish the Page.
2. A Start Workflow screen will appear. Click again.
3. A new screen will then display prompting two choices. If you wish to submit the page for publishing click “Submit for publishing”. If you wish to not publish the asset but want to save your changes so that you can continue to edit click “Continue editing”.
4. Enter any relevant notes into the comment box. Anything entered here will be sent to the WCMS Managers. It is recommended that you briefly describe your changes made to the page, but comments are optional. Click .
5. If “Continue editing” was chosen your screen will show the page’s edit page. If “Submit for publishing” was chosen the page’s workflow detail page will display.

5.5 Deleting Pages
To delete pages, perform the following steps:
1. Start by locating the page you wish to be deleted in the NUIT-MAIN file tree and click the page.

Base Folder/training/index

2. Once the page has loaded, click on the More tab located above the page.
3. Select Delete from the More tab menu.
4. Click .
5. The Start Workflow screen will appear. Input comments regarding reasons for page deletion and click again.
6. The workflow detail page will display. IT Communications will review your submission. Notification will be sent confirming completion of the workflow.
Note: You are able to access deleted pages in the Recycle Bin, located in the Home Dashboard, for up to 15 days post-deletion.
6.1 Glossary

**additionalInfo**
The additionalInfo is a customizable field found on any Basic Page asset. additionalInfo will populate the “Additional Information” region found on the page below the main body content section.

**additionalInfoNav**
The additionalInfoNav is a customizable field found on any Basic Page asset. additionalInfoNav will populate the “additionalInfoNav” region found on the page’s Navigation Menu.

**Asset**
An asset is any entity within the system that can be used to generate content. For ease of classification, assets are divided into several different groups:

1. **Page** - This is a mutable asset built by the WCMS from other assets to create the finished product of published documents such as web pages or XML documents.

2. **File** - may be a jpg image, CSS file, or any other static content.

3. **Block** - a “pluggable” piece of content that can be easily substituted, with or without styling, into any page region. As the name suggests, these are the building blocks from which other blocks and pages are built.

4. **Format** - used to transform and style data, such as an XML block.

5. **External Link** - a symbolic link to a specific URL.

6. **Folder** - a container within NUIT WCMS that acts a parent asset to other assets.

7. **Template** - the basic building block for a page’s layout.

8. **Reference** - a special asset that is created to represent an existing asset in another location, allowing it to be indexed in multiple folders.

**Base Folder**
The base folder is the top-level folder for assets located in the NUIT-MAIN Home area.
**Basic Page Asset Factory**

A Basic Page Asset Factory provides a way to create new Basic Page assets.

**Body Contents**

The Body Contents is a customizable WYSIWYG field found on Basic Page assets. Body Contents is populated with content unique to that asset.

**Continue editing**

Continue editing is a workflow option resulting in an asset being saved as a new version in NUIT-MAIN, without being published to the NUIT Web Site.

**Contributor**

Contributor is a role in WCMS that can be assigned to a user. The Contributor role is a basic role that allows users to manipulate content, with adherence to workflow, in the NUIT WCMS. Contributors may be given read or write access to areas in the NUIT-MAIN asset tree. These access permissions are set by Managers at the folder level.

**Dashboard**

Upon logging in, every user is greeted with a personalized dashboard showing messages, current workflows, assets checked out, and much more general information.

The Dashboard allows users to customize viewing preferences and manage workflows more efficiently in a workspace environment best suited to the individual user.

The Dashboard, also referred to as the Home Area, is used to supply the user with a summary of the activities that require user attention. The dashboard can be accessed at any time by selecting **Home** tab from the main menu.

**Display Name**

The Display Name field is the short name of a Basic Page and may be distinct from the system name. Display Name will populate the header for the additionalInfoNav region on the Navigation Menu.

**File Upload**

File Upload is an option available when creating/editing documents and images. File Upload allows a user to select a file to upload from the /bin or /image folders found in the NUIT-MAIN asset tree. When creating an asset, if no name has been specified, the name of the file from the hard drive will be inherited.
Folder

A folder contains a group of related assets. The Asset Tree can be seen to the left of the NUIT WCMS window.

Clicking on a folder will expand the folder view in the asset tree, revealing the assets and/or subfolder(s) inside. Additionally, clicking on a folder from the asset tree will open it in the main viewing area as well.

History

From any page in the system, users can click on the History tab on the top menu bar to see a list of their most recently viewed assets.

IT Communications

IT Communications are the WCMS Managers of the NUIT WCMS.
Contact: it-communications@northwestern.edu

HTML Toggle

The HTML Toggle is a WYSIWYG feature that allows users to edit content in HTML.

Keywords

Keywords are part of the metadata content for page assets and are used by search engines to determine the relevancy of individual pages or sites. Typically, keywords are a comma-delimited list of words used on pages and generated in such a way that the page can receive higher points in a search engine query.

Locked Asset

This process of locking an asset is called “Checking Out”, while releasing such a hold on the asset is referred to as “Checking In”. If a user has checked out an asset and wishes to cancel his or her changes, that user would then break or cancel the lock, effectively discarding the changes. Checking in changes made to a locked asset commits the changes back into the CMS and breaks the lock.
Metadata
Metadata is data within the WCMS that describes an asset. Common fields such as title, summary, or keywords provide quick information about the content contained inside of a particular asset.

Navigation Menu
The Navigation Menu is a region found on Basic Page assets.

NUIT-MAIN
NUIT-Main is the site container for the NUIT Web site <http://www.it.northwestern.edu>.

Page
The Page is one of the core asset types in the WCMS. Pages are the grouping of many smaller assets.

Preview
Preview is a view in WCMS that enables the user to view a page as it will appear once it has been published.

Recycle Bin
The Recycle Bin is a temporary holding area for deleted assets to help prevent loss of content. Assets in the Recycle Bin can be restored to their original location or purged from the system permanently for up to 15 days post-deletion. Locate the Recycle Bin in the Home Dashboard or Quick Links.

Submit for publishing
Submit for publishing is a workflow option resulting in an asset being saved as a new version in NUIT-MAIN and published to the NUIT Web Site.

Support Contact
Support Contacts specify the name and contact information for that specific page. Support Contacts are listed below the Additional Information section of the basic page. The default Support Contact for all pages is the NUIT Support Center. If your page requires a different Support Contact, contact NUIT Communications.

System Name
The System Name is a field on an asset that will act as the file name as seen in the NUIT-MAIN asset tree.

Title
The title field on a Basic Page is a longer version of the display name. It will populate the Title Region of the Basic Page and it is used in the title bar of the browser.

User
A user is any individual who uses the NUIT WCMS. Users of NUIT WCMS are defined by their NetIDs, role designations, and the groups they belong to.
Version
The NUIT WCMS maintains a full version history on each asset in the system. As changes are made to any asset in the system, WCMS keeps track of the changes in separate copies of the asset called Versions. These are accessible through the Advanced tab of any asset in the Home area by simply clicking “Advanced” and selecting “Versions” from the drop-down.

The versions list for each asset shows a list of each version, the author for each change, including the original creator of the asset, as well as the time and date of the change and any notes available. Users may navigate through the various versions, compare them with the current version, and activate any version desired.

WCMS Manager
WCMS Manager is a role in the system that permits full, uninhibited access to any asset and/or area of the system. The IT Communications team are the WCMS Managers of the NUIT Web site.

Workflow
When creating Web content (assets: a page, file, image, etc.), a workflow is a series of ordered steps that the content must go through to be quality-checked, and either approved, modified, or disapproved by a Manager before being publish-ready.

WYSIWYG
WYSIWYG is an acronym for “What You See Is What You Get.” That allows you to see formatting while editing in your content in the word processor. The word processor, which is integrated in the NUIT WCMS system, has the same functionality and features you are most likely accustomed to using in a standard editor. The functions available in the WYSIWYG are all available at the top of the editing content window (as with most word-processors), and include:
Northwestern University Information Technology (NUIT) Web Business Process for Using the NUIT WCMS

As supported by Northwestern University Web Guidelines

Prepared by:

Office of Web Communications
Department of University Relations
Northwestern University

and

NUIT Communications
Northwestern University Information Technology (NUIT)
Northwestern University
# Table of Contents

- **Introduction** 3
- **Purpose of NUIT’s Web Standards** 3
- **Compliance** 3
- **Policy** 4
- **NUIT Requirements** 5
- **University Requirements: Accessibility** 5

## NUIT Web Site Policies
- Responsibilities of Contributors 6
- Process for Updating NUIT Web pages 7
- Content Recommendations 7
- Editorial Guidelines 7
- Media and Image Files 9

## NUIT Business Process for Web Pages Outside of the Web Content Management System (WCMS)

- **Contact Information** 10
Introduction

Northwestern University Information Technology (NUIT) Communications created the following Web guidelines to assist NUIT staff and departments in making informed decisions when creating Web pages and publications under the NUIT branding.

NUIT’s Web standards exist to facilitate consistency and usability and to promote standardized NUIT branding across the University Web sites. Any Web document that represents Northwestern University and/or its official units, programs, departments, or schools is expected to follow University Web standards.

The Purpose of NUIT’s Web Standards:

- **Identity**: Branding allows visitors to recognize immediately a Web page’s affiliation with Northwestern University and NUIT.

- **Usability**: NUIT Web sites must be intuitive and functional for the NU Community.

- **Consistency**: Web standards promote consistency. Consistency simplifies navigation of pages for end-users of the NUIT Web site. NUIT is committed to maintaining a high level of consistency across all Web pages in the NUIT Web site.

- **Accuracy**: Pages must be accurate and up-to-date.

Compliance

NUIT abides by the official University Web Standards. For more information, please visit [http://www.northwestern.edu/univ-relations/webcomm/styleguide/](http://www.northwestern.edu/univ-relations/webcomm/styleguide/).

All pages must adhere to NUIT Standards. Staff should focus on creating accurate, regularly updated content that supports the mission of NUIT.
Policy

All NUIT departments are to adhere to the policy standards outlined in this document as well as to Northwestern University Web standards. Any Web pages created by NUIT departments, or by subgroups within the departments, should link directly from the main NUIT Web site (or from the home page of the respective NUIT department, as appropriate) to assure ease of navigation and to minimize the amount of searching required to find information.

With the exception of iCAIR, which has unique branding and different site location appropriate to their function externally from the University, NUIT departments should not create “stand-alone” Web sites that are not linked from the NUIT Web site or otherwise lack official NUIT branding, including look and feel.

In addition, any new Web pages or major changes to existing Web pages within and/or affiliated with the NUIT Web site are subject to review by NUIT Communications. This process is not intended to dictate what each NUIT department can or cannot put on the Web, but is meant to help assure consistency of content and a unified image of the NUIT organization.

Content on the NUIT Web site must conform to NUIT Web guidelines including appropriate placement within the NUIT Web structure. NUIT Communications is charged with ensuring that all Web pages and their content adhere to these guidelines.
NUIT Requirements

Required elements that must be on all NUIT Web pages within and/or affiliated with the NUIT Web site are as follows:

- Northwestern University Logo
- NUIT Logo and CSS
- Standard NUIT Footer (within the CSS)
- Title Tag
- University Search box
- Meta Tags
- Breadcrumb Navigation

All of the above requirements have been incorporated into templates available through NUIT's Web Content Management System (WCMS). These templates must be used when creating and updating Web content.

University Requirements: Accessibility

Accessibility should be a priority for all Northwestern University Web publishers. Northwestern University is committed to providing equal access to Web-based information in accordance with the Rehabilitation Act of 1973 and the Americans with Disabilities Act (ADA), and the NUIT Web site will operate in agreement with this Act. These acts help ensure that Web pages will be readable by users with disabilities.


Note that the ADA stipulates that federal funding may be withheld from institutions that fail to adhere to its rules.
NUIT Web Site Policies

Access
Only authorized and trained NUIT staff are able to access the Web Content Management System (WCMS) to make edits to pages within the NUIT Web site.

Editing Pages
Web pages are edited by the authorized staff acting as Web contributors. Contributors are considered content experts and are responsible for ensuring that their content is approved by their departments before it is deployed by NUIT Communications. Pages are NOT to be edited outside of the NUIT Web Content Management System (WCMS).

Secondary Workflow and Student Employees
Web contributors must contact NUIT Communications to request a secondary workflow system when WCMS access is requested for a student employee. Implementation of secondary workflow ensures that a fully trained NUIT staff member has reviewed and approved page content before it is deployed by NUIT Communications. Once secondary workflow is established, the NUIT Web contributor is responsible for training all student employees using the WCMS Contributor Manual at http://www.it.northwestern.edu/bin/docs/WCMS_Manual_Contributor.pdf. Request a printed copy from NUIT Communications at it-communications@northwestern.edu.

Standards
All pages must adhere to the NUIT standards set forth in this document. Contributors will focus on creating accurate, regularly updated content that supports the mission of NUIT.

Responsibilities of Contributors

- All NUIT Web pages must be reviewed and approved by department stakeholders and NUIT Communications before uploading.

- All NUIT Web contributors and NUIT departments are responsible for the content of their pages.

- All content should be monitored to ensure that it is updated as necessary. Contributors are expected to review all content in a timely manner to ensure that the information presented to NUIT users is current.

- All NUIT Web contributors must ensure that their content is up-to-date and does not violate University policies and codes or federal, state, and local laws.

- All NUIT Web contributors are expected to follow the University’s principles of academic integrity.

- Any NUIT pages found to be in violation of the standards and policies set forth in this document or any amendments to it will be removed from the NUIT Web site until corrections
are made.

- Vendor links: Official University pages may not link to commercial sites that advertise/sell products or services and may not accept sponsorship from commercial entities in exchange for advertising and/or links to commercial sites. Specific exceptions may be allowed if the commercial links support the University’s mission and/or provide an essential service to the Northwestern community (for example, software vendors). All links on NUIT Web pages are subject to review by NUIT and/or the Office of Web Communications.

**Process for Updating NUIT Web Pages**

The process for updating the NUIT Web site is detailed in the WCMS Contributor Manual at [http://www.it.northwestern.edu/bin/docs/WCMS_Manual_Contributor.pdf](http://www.it.northwestern.edu/bin/docs/WCMS_Manual_Contributor.pdf). Because contributors have access to different assets, a process will be specifically created within the WCMS for each contributor in order to best meet departmental needs. The approval process will be automated within the system.

**Content Recommendations**

**Organization: User Focus vs. Internal Focus**
Organize sections and content according to users’ needs, not necessarily by departmental organization or hierarchy. Identify items your users would logically want, even if it means grouping functions from different areas. For example, the service that NUIT offers is more important to the user than the NUIT group that is responsible for that service.

**Editorial Guidelines**

**Writing for the Web**
Users want to find what they are looking for as quickly and easily as possible. Web-savvy writing and editing are essential for optimal content delivery. Templates are provided within the WCMS, and all content entered must fit within these templates, ensuring that the look of the page is consistent with the NUIT site as a whole.

**Key Concepts**
- Omit needless words. Users don’t read—they scan.
- Define and clarify technical terms and jargon.
- Be succinct, informative, and use the grammatical second or third person, never first person.
- Use “inverted pyramid” writing style: start with the point, then support it, using links for in-depth details.
- One idea per paragraph is ideal.
- Keep the most important elements “above the fold,” that is, visible on initial page view without scrolling.
• Categorize according to users’ needs, not necessarily by departmental organization or hierarchy.
• When creating a link, highlight only the one, two, or three most important words.

Consistency of Style
Style guidelines have been established by University Relations and NUIT and should be followed.

NUIT Editorial Style Guide
For NUIT-specific style elements such as usage, punctuation, and capitalization, please refer to the NUIT Editorial Style Guide. This can be found on the NUIT Intranet at http://www.it.northwestern.edu/bin/docs/secure/intranet/nuiteditorialguidelines.pdf.

A to Z Style Guide
The University Relations Publications Group has produced a guide http://www.northwestern.edu/univ-relations/publications/resources/styleguide.html that addresses many stylistic issues you are likely to encounter in Northwestern University-related communications. Standard University terminology is found here. If you have any questions regarding reference to a specific University entity, confirm information directly with that entity, in the University’s printed faculty/staff/student directory, or through the University Relations Publications Group at 847-491-4880.

Content Maintenance
Pages must be accurate and up-to-date. Establish an updating system and identify specific people to help maintain content validity.

Copyright Issues
Copyright protects expression – your expression and that of others. All original expression is eligible for copyright protection as soon as it is fixed in a tangible form. Almost all original expression is protected as soon as it is expressed. Virtually everything you can upload and download on the Web is protected by copyright.

• Items NOT eligible for copyright protection:
  o Ideas
  o Facts
  o Titles
  o Names
  o Short phrases
  o Blank forms

• You must have permission from the copyright holder. While it is easy to download and copy files (text, photographs, graphics, sound, movies, etc.) from the Web, this is not tolerated on the NUIT Web site.

• The University is obligated to take appropriate action if it receives a complaint that copyrighted material is being published over its network without permission under the terms of the Digital Millennium Copyright Act.
• **NUIT pages must contain copyright notice.** The standard Northwestern University footer contains a copyright notice. If you wish to use copyrighted material, send a Copyright Request Form to the content owner. This form is available through University Web Communications.

**Media and Image Files**

All media must be approved by the director of the requesting department.

• NU University Relations provides the following subject and talent release forms for photography and video and audio recording. This University standard release form must be used for any media in which people are identifiable. You can find the form at [http://www.northwestern.edu/univ-relations/publications/resources/photo.html](http://www.northwestern.edu/univ-relations/publications/resources/photo.html).

• GIF and JPG are the most common formats for Web graphics. Their size should be small enough to load quickly (~50K).
  
  o **GIF**
    
    ▪ Better for solid colors
    ▪ Render with a transparent background to avoid dithering
    ▪ Smaller file size
    ▪ Smaller color palette
  
  o **JPG**
    
    ▪ Better for images with subtle variations of color (example, photographs)
    ▪ Higher compression tends to degrade quality; adjust compressions to avoid larger file size and bad image quality

**Video, Digital Media, and Interactive Elements**

• All require the approval of the NUIT server administrators.

• If your Web page includes Flash, JavaScript, animations, or other elements that are not universally accessible, be sure to include text descriptions of these elements in accordance with the ADA Guidelines for the Web.
NUIT Business Process for NUIT Web Pages Outside the Web Content Management System (WCMS)

There may be incidences in which a Web page or Web site needs to be developed and maintained outside of the NUIWT WCMS. In these cases, all NUIT Web branding and style guidelines must be followed to ensure a consistent and seamless look with existing NUIT pages and sites.

If a project or service is developed using NUIT resources for faculty or research efforts, and is funded by a “customer,” then it needs to clearly display NUIT Web template branding.

For Web pages that include dynamic content or system access outside of NUINFO or the WCMS, NUIT Communications will provide the NUIT Web template which can then be applied to those pages. For projects that may require special circumstances, please contact NUIT Communications for a consultation meeting to discuss how to best proceed in maintaining a connection to the NUIT Web site and brand appropriately.

In an effort to move all NUIT supported Web pages to the NUIT WCMS, this business process applies to all existing and new NUIT Web pages created and maintained by NUIT resources.

Contact Information

If you have questions regarding the NUIT Web Guidelines, general NUIT Web queries, or support questions, please send a message to it-communications@northwestern.edu.
Northwestern University Information Technology (NUIT) Editorial Style Guide

As supported by University Relations Style Guide

Prepared by:

NUIT Communications
Northwestern University Information Technology (NUIT)
Northwestern University
NUIT Editorial Style Guide

The following editorial guidelines have been developed to promote consistency in text presentation for publications, press releases, advertisements, and other print material produced by NUIT. The same style guidelines should be followed for NUIT Web pages.

This guide supplements the University Relations Style Guide, available online at http://www.northwestern.edu/univ-relations/publications/resources/styleguide/.

General Guidelines

1) NU and NUIT Branding

When preparing material for print, including posters, flyers, Daily Northwestern advertisements, etc., always include NUIT branding. Spell out Northwestern University Information Technology and include the Web address: www.it.northwestern.edu.

Do not use the Northwestern University logo for NUIT print publications (e.g. Annual Report, Strategic Plan, eCommunicator) without accompanying NUIT branding. See www.northwestern.edu/logo/ for guidelines regarding use of the Northwestern University logo.

2) Review/Approval Process

All print material should come through NUIT Communications for style and content review. Please contact the Manager of NUIT Communications.

Please allow sufficient lead time for the review process. NUIT Communications needs at least one week to review material.

All major changes to existing NUIT Web pages must be approved by NUIT Communications. For guidelines relating to the creation of new NUIT Web pages (including the approval process), please refer to NUIT Web Standards, Policies, and Procedures.

3) Hierarchy of Information

For articles and publications intended for University audiences, always refer to NUIT first, then the individual NUIT department. For example: “NUIT Technology Support Services,” not “Technology Support Services.” (Also see Identifying the NUIT Organization below.)

Identify units within NUIT departments appropriately. For example, in a press release where NUIT has already been identified: “NUAMPS (Northwestern University Advanced Media Production Studio), a unit of NUIT Academic and Research Technologies...”
Exceptions: For the sake of simplicity, write **NUIT Distributed Support Services (DSS)** and **NUIT Communications**. The fact that these are sub-units of NUIT Technology Support Services does not need to be spelled out.

When writing about iCAIR, use “Northwestern University's International Center for Advanced Internet Research (iCAIR).” Follow up with “iCAIR is a division of Northwestern University Information Technology (NUIT).”

For articles and publications intended for audiences outside the University (material to be submitted by NUIT Communications to University Relations), identify the University first, then NUIT, then the individual NUIT department as appropriate.

When referring to groups within the Northwestern community, use: “students, faculty, and staff,” in that order.

When referring to NUIT’s central e-mail servers, use: “casbah, hecky, lulu, and merle,” in that order.

4) **Identifying Northwestern University/NU**

In general, do not use NU for Northwestern in article text. NU is permissible in internal communications (e.g. the NUIT Staff Newsletter) and in headlines.

*Exception*: If NU is used in context (e.g. in the “Getting Connected” newsletter for new students), usage is “**Northwestern University (NU)**” on first reference.

Always capitalize University when referring to Northwestern (“the University”).

It is the **NU Network**.
5) Identifying the NUIT Organization

When referring to the NUIT organization in articles for publication outside NUIT, use Northwestern University Information Technology (NUIT) on first reference and NUIT thereafter.

Never identify the organization as “NU Information Technology.”

NUIT is acceptable in internal e-mail and publications. It is not necessary to spell out NUIT on NUIT Web pages (i.e., pages that fall under the NUIT template).

Within a NUIT publication (e.g. the eCommunicator), use Northwestern University Information Technology (NUIT) in the first reference, first article only and use NUIT elsewhere.

NUIT Communications is always spelled out and always ends with an “s.”

6) Other Style Elements (usage, punctuation, capitalization, typography)

Always hyphenate the term e-mail.

Use the phrase “junk e-mail” to refer to unwanted e-mail. Do not use spam, which is a registered trademark of Hormel Foods Corporation.

Do not use brackets to enclose e-mail addresses in print or online publications, including e-mail messages.

Do not use boldface or a contrasting color for e-mail addresses in print publications.

Do not use http:// at the start of a Web address in a print publication, unless the address doesn’t start with www or there might be confusion about whether it is a Web address.

Use http:// where appropriate for Web addresses within e-mail, if the intent is to create an active link to the site. Always check to ensure that links work and that they direct the reader to the correct page.

Always embed Web links in online publications (e.g. create a “live” link to a site rather than including the actual URL within text).

Use the less-than < and greater-than > symbols to enclose Web addresses in print, e.g. <www.it.northwestern.edu>.

Use a contrasting color for Web addresses in print publications.

Retain a trailing slash / in a Web address if it indicates a directory: <www.it.northwestern.edu/learning/>.
Do not use **index.html** at the end of a Web address in print publications; instead retain the trailing slash for the directory.

Capitalize **Internet** and **Web**.

Use **Web site** as two words.

Use **videoconference** (or **videoconferencing**) as one word.

Capitalize **Webcast** when used as a noun. Do not use as a verb (e.g. “NUIT Webcast several events last quarter”); substitute “broadcast over the Internet.”

Never break a Web or e-mail address between two lines except at the @ or /.

Always bold **1-HELP** when writing the NUIT Support Center phone number: 847-491-HELP (4357). Always include the (4357) after **1-HELP**.

Use dashes to separate sections of telephone numbers.

**Standard signoff** (e-mail, press releases, etc.): “For additional information, please contact your departmental/school technical support person, call the NUIT Support Center at 847-491-HELP (4357), or e-mail consultant@northwestern.edu.”

**Titles and Capitalization**

*From the University Relations style guide:*

Uppercase preceding a name if it’s a title by which the individual is called (Professor Smith, Dean Van Zandt, Provost Dumas), but lowercase a functional title (program director Jane Johnson). Thus, it’s Dean Barbara J. O’Keefe of the School of Communication but School of Communication dean Barbara J. O’Keefe.

*From the Chicago Manual of Style:*

Professional titles are capitalized when they immediately precede a personal name, as part of the name (President Schapiro, Mayor Daley, Prince Charles)

Titles following a personal name or used alone in place of a name are usually lowercased (Morton Schapiro, president of Northwestern University; the president; Richard M. Daley, mayor of Chicago; the mayor)
Step-by-step Instructions

Step-by-step instructions should be in a numbered list. Actions (e.g. click, double-click, select, navigate, etc.) should be italicized. Buttons, menus, and menu selections should be bolded. Use a period at the end of each step. For example:

1. *Go* to the **Course Home** page.
2. *Click* **Add Course Module**.
3. *Click* the **box** next to the Course Module to be added.
4. *Click* **Submit**.

Avoid sub-steps in lists (e.g. a, b, c, i, ii, iii). If a list item must have sub-steps, use bullets instead of numbering.

Contact Information – NUIT Communications

If you have questions regarding the NUIT Editorial Style Guide, please send a message to it-communications@northwestern.edu.
Appendix A: NUIT Press Release Template

FOR IMMEDIATE RELEASE

Headline is Times New Roman 12pt. bold, lower case except for proper nouns

Body copy should be Times New Roman 12 pt. Use 1-1/2 line spacing for ease of editing and double-space between paragraphs.

End pages at the end of a paragraph whenever possible.

Identify and number page 2 and succeeding pages at the top left-hand corner with two or three boldface words based on the first page headline and the page number, single-spaced. For example:

Headline in bold
Page 2

Type "-more-" at the end of each page if there is another page following.

Always include relevant contact information in a press release. For example:

"Please direct questions to the NUIT Support Center at 847-491-HELP (4357) or consultant@northwestern.edu."

Date